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基礎知識

基礎知識
このマニュアルは、Maya ゲームトランスレータの使用方法について説明してい
ます。

重要: Maya 4.0 以降では、Maya の API を直接使用することをお勧めします。
MDT レイヤが Maya 1.0 用に開発されて以来、API にいくつもの関数が追加され
たので、MDT レイヤを使用する必要は減りました。

Maya ゲームトランスレータは、Autodesk のライセンスを受けたユーザに提供さ
れます。また、提供された Maya ゲームトランスレータをユーザサイトで独自に
カスタマイズできるように、トランスレータのソースコードと MDtApi も提供さ
れます。

VRML2、RTG、GE2 の各ゲームトランスレータは API インタフェースレイヤ
（MDtApi）で書かれています。MDtApi 機能は Maya API を使用して実装されて
います。MDtApi は、いかなる形式の Maya API も代替することはありません。
Dt 機能は、トランスレータ機能と他のプラットフォーム間でのソースコードの再
利用を容易にし、API ソースコードのサンプルを提供することを目的としていま
す。

ゲームトランスレータは、ファイル > すべてエクスポート（File > Export All）
またはファイル > 選択項目のエクスポート（File > Export Selection）メニュー項
目からアクセスできるファイルトランスレータ（File Translator）プラグインで
す。

1
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トランスレータ内部処理の、2 つの基本的な段階
■ Maya のシーン情報に比較的簡単にアクセスできる内部データベースを作成

します。このデータベースはグループ化メカニズムと考えることができます。

■ このデータベースの情報を使用してトランスレータを起動します。

トランスレータの起動プロセスには、ユーザの設定が必要なオプションがいくつ
かあります。これには、内部データベースをセットアップするオプションセッ
トと、実際にトランスレータを起動するためのオプションセットがあります。

内部データベースの共通オプション
アニメーションオプション（Animation Options） フレームレンジ、要求され
たアニメーションのレベルなどを含む

エクスポート オプション（Export Options） 階層情報、テッセレーションパ
ラメータ、冗長動作のレポートなどを含む

テクスチャ オプション（Texture Options） シェーダ評価パラメータを含む

その他のオプション: トランスレータ固有のオプション

ゲームトランスレータを実行する
Maya ゲームトランスレータには VRML2、RTG、および GE2 が搭載されてい
ます。

トランスレータを起動するには、次の 2 つのプロセスを実行します。

■ ウィンドウ > 設定/プリファレンス > プラグインマネージャ（Window >
Settings/Preferences > Plug-in Manager）ウィンドウからトランスレータを
ロードします。

■ トランスレーションを開始するには、ファイル > すべてエクスポート（File
> Export All）またはファイル > 選択項目のエクスポート（File > Export
Selection）メニュー項目を選択するか、MEL スクリプトから次のコマンド
を使用します。

file -rename output_filename

file -exportAll

または

2 | 第 1 章 基礎知識



file -exportSelected

トランスレータをカスタマイズ/再作成する
次に、トランスレータを再コンパイルしたり、再作成する方法について説明しま
す。

トランスレータを再コンパイルするには

1 再コンパイルする前に、次の C++ コンパイラを用意します。

（Linux®）SGI C++ 7.3.1

（Windows®）Microsoft® VC++ 6.0

（Mac® OS X）Metrowerks® CodeWarrior 7.1

2 ローカルな作業領域を作成して、次のようなディレクトリツリーを構成す
ることができます。
MDt/MDtApi

MDt/include

MDt/lib

MDt/vrml2Export

MDt/rtgExport

MDt/ge2Export

3 $MAYA_LOCATION/devkit/obsolete/games から個々のディレクトリをコ
ピーします。

Maya は、CodeWarrior®、SGI®、MS IDE プロジェクトファイル用の
Makefile を付属しており、これらを使ってトランスレータを再作成できま
す。

注: 場合によっては、Makefile を編集して、Maya の特定のインストール領
域のプロジェクトファイルをカスタマイズする必要があります。

4 はじめに、MDtApi ライブラリを作成します。ほかのトランスレータも使
用できるスタティックライブラリを作成します。これを LIB（Mac OS X）、
DSO（Linux）、または DLL（Windows）ファイルとして作成することも
可能ですが、当面はトランスレータを更新したり変更するためのスタティッ
クライブラリを作成するほうが簡単です。
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（Linux）libMDtApi.a は lib ディレクトリにコピーされてそこから参照さ
れます。

（Windows）libMDtApi.lib は Release サブディレクトリに格納されてお
り、そこから参照されます。

（Mac OS X）libMDtApi.lib は CFMSupport フォルダに格納されており、
そこから参照されます。

必要なトランスレータを構築する
注: Mac OS X の場合、ライブラリが既に提供されているのでトランスレータを
構築する必要はありません。

1 トランスレータのプラグインファイルをユーザの Maya 作業領域のプラグ
インディレクトリにコピーします。次のようなディレクトリ構造の作業領
域にコピーしてください。
$HOME/maya/prefs

$HOME/maya/projects

$HOME/maya/plug-ins

$HOME/maya/scripts

2 ウィンドウ > 設定/プリファレンス > プラグインマネージャ（Window >
Settings/Preferences > Plug-in Manager）から、カレントバージョンのプ
ラグインをアンロードします。

3 新しいバージョンのプラグインをコンパイルします。

4 新しいトランスレータプラグインを plug-ins ディレクトリに、MEL オプ
ションスクリプトを scripts ディレクトリに、それぞれ格納します。

5 ウィンドウ > 設定/プリファレンス > プラグインマネージャ（Windows >
Settings/Preferences > Plug-in Manager）から、プラグインをリロードし
ます。

6 MEL オプションスクリプトを変更した場合は、その変更が Maya 内部で更
新されるように、スクリプトエディタ（Script Editor）のファイル（File）
メニューよりソーススクリプト...（Source Script...）を選択し、再度 MEL
スクリプトを読み込みなおします。そうしなければ、変更は反映されませ
ん。
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7 トランスレータを起動します。

異なるプラットフォームへのインストール
ゲーム用のトランスレータは、Maya ソフトウェアの devkit/games 下に標準で
インストールされます。

ゲーム用トランスレータのディレクトリ構造は、Maya を実行するプラットフォー
ムによって異なります。

注: 次のディレクトリの場所の場合、Windows では Maya がドライブ C にイン
ストールされていることを前提にしています。そうでない場合は、「C」を変更
し、WindowsMaya がインストールされているドライブを参照するようにして
ください。

トランスレータのバイナリイメージ .lib（Mac OS X）、.so（Linux）または
.mll（Windows）は次のディレクトリにあります。

■ （Linux）/usr/autodesk/maya2011/bin/plug-ins/

■ （Windows）C:\Program Files\Autodesk\Maya2011\bin\plug-ins

■ （Mac OS X）/アプリケーショ

ン/Autodesk/maya2011/Maya.app/Contents/plug-ins

ユーザオプションに使用する MEL スクリプトファイルは次のディレクトリに
あります。

■ （Linux）/usr/autodesk/maya2011/scripts/others/

■ （Windows）C:\Program Files\Autodesk\Maya2011\scripts

■ （Mac OS X） /アプリケーショ

ン/Autodesk/maya2011/Maya.app/Contents/scripts

トランスレータを起動するのに必要なファイルは、通常、プラグインのバイナリ
ファイルと MEL オプションファイルだけです。ソースコードが必要な場合は、
devkit ディレクトリツリー下にあります。

■ （Linux）/usr/autodesk/maya2011/devkit/obsolete/games/
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■ （Windows）C:\Program

Files\Autodesk\Maya2011\devkit\obsolete\games

■ （Mac OS X）/アプリケーション/Autodesk/maya2011/devkit/obsolete/games

これらのディレクトリには、次のサブディレクトリがあります。

■ MDtApi

■ include

■ vrml2Export

■ rtgExport

■ ge2Export

注: lib ディレクトリを別途作成してください。lib ディレクトリはデフォル
トでは作成されません。

Maya にトランスレータをロードする
ゲーム用のプラグインをプラグインリストに追加したら、ロードして使用しま
す。

1 ウィンドウ > 設定/プリファレンス > プラグインマネージャを選択して、
プラグイン マネージャ（Plug-in Manager）ウィンドウを開き、認識され
ているプラグインをすべて表示します。

2 目的のプラグインを検索してロード（loaded）チェックボックスをクリッ
クしてプラグインをロードします。自動ロード（auto load）チェックボッ
クスのみをオンにした場合は、Maya を再起動してプラグインをロードする
必要があります。
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VRML2 トランスレータ

VRML2 の概要
VRML2 トランスレータは、Maya のシーンファイルを VRML2 フォーマットにエ
クスポートします。NURBS サーフェスはポリゴンにテッセレーションしてから出
力されます。

注: VRML2 トランスレータでは、Maya のすべての機能セットが出力されるわけ
ではありません。

VRML2 の機能

出力
■ ポリゴンジオメトリ

■ NURBS サーフェス（三角形または四角形にテッセレーションされます）

■ 階層構造（必要な場合）

■ VRML2 プリミティブ（タグ付きの場合）

■ シェーダのパラメータ

■ テクスチャ（SGI の RGBA イメージフォーマット）

■ リジッド TRS アニメーション

■ 頂点のアニメーション

■ カメラ情報

2
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■ ライト情報

コマンド

VRML2 トランスレータには MEL コマンドが組み込まれています。この
vrml2Tags コマンドを使用すると、オブジェクトのダイナミックアトリビュー
トを定義することができます。ダイナミックアトリビュートの値は VRML2 ト
ランスレータによって参照され、出力ファイルの定義に使用されます。

アトリビュート

VRML2 トランスレータでは、次のダイナミックアトリビュートを定義して使用
することができます。

■ userAnimated boolean: On = force vertex animation processing

■ VRML2 Primitive: long, cube/plane

■ VRML2Billboard: long, camera facing/Y facing/Z facing

このプラグインに必要なファイル

このプラグインを使用するには、次のファイルが必要です。

■ vrml2Export.lib（Mac OS X）、vrml2Export.so（Linux）、または
vrml2Export.mll（Windows）

■ vrml2TranslatorOpts.mel

ソースコードは、以下のディレクトリにあります。

（Linux） /devkit/obsolete/games/vrml2Export

（Windows）Program

Files\Autodesk\Maya2011\devkit\obsolete\games\vrml2Export

（Mac OS X）アプリケーション/maya2011/devkit/obsolete/games/vrml2Export

制限事項
■ Mac OS X の場合、VRML2 Exporter はテクスチャをエクスポートしません。

■ VRML2 の輝度の範囲は [0～1.0] です。Maya には制限がありません。Maya
ではこの制限がないため、VRML2 トランスレータは [0～100] のスケーリン
グを前提として、Maya の輝度の範囲を 0 ～ 1.0 に収まるように縮小します。
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■ 負のスケール値についてはチェックされません。VRML2 では 0 以上のスケー
ル値が前提とされます。

■ 出力されるファイルテクスチャは SGI の RGB/RGBA フォーマットに限られ
ます。Microsoft の VRML2 ビューアは RGB/RGBA フォーマットをサポート
していません。Cosmoplayer を使用すると、Linux システム上と Windows
システム上の両方でこのテクスチャファイルを読み込むことができます。
Windows システム上でアプリケーションの自動起動機能が設定されている
場合、Explorer の代わりに Netscape をファイルタイプやアプリケーション
と関連付ける必要があります。

■ テクスチャを正しく回転させるには、テクスチャ オプション（Texture
Options）アトリビュートをサンプル（Sample）に設定する必要がありま
す。

■ VRML2 トランスレータにはメモリリーク（漏れ）が発生する場合がありま
す。これは、中間的な内部構造体が一部残ってしまうためです（たとえば、
Maya 1.0 で NURBS サーフェスをアニメートすると、テッセレーションのた
めにかなり大量のメモリリークが発生します）。

■ 頂点のアニメーションは inMesh アトリビュートのコネクションに基づいて
実行されるため、実際より多くのジオメトリがアニメートされたとみなされ
る可能性があります。必要な場合は、アニメーションの仕上げとして、アニ
メートされていない tweak（ツィーク）のヒストリをクリーンアップしてく
ださい。
userAnimated というダイナミックアトリビュートの強制使用についてチェッ
クされるようになりました。アトリビュートの追加（Add Attribute）コマン
ドを使用して、userAnimated ダイナミックアトリビュートをブールフラグ
として追加し、頂点のアニメーションを強制的に認識させて使用したいオブ
ジェクトに対して、このアトリビュートをオンに設定します。このダイナミッ
クアトリビュートは、ほとんどがコンストラクションヒストリのないオブ
ジェクトや inMesh コネクションのようなオブジェクトに適用します。

■ インスタンス化したジオメトリは複数出力されますが、このジオメトリは再
利用されません。

VRML2 トランスレータをインストールする
プラグイン マネージャ（Plug-in Manager）を使用して、プラグインの VRML2
トランスレータをインストールします。
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1 ウィンドウ > 設定/プリファレンス > プラグインマネージャ（Window >
Settings/Preferences > Plug-in Manager）を選択して認識されるプラグイ
ンをすべて表示します。

2 vrml2Export.so（Linux）、vrml2Export.mll（Windows）、または
vrml2Export.lib（Mac OS X）の隣のロード（loaded）チェックボックス
をクリックして、プラグインをロードします。

自動ロード（auto load）チェックボックスのみをオンにした場合は、Maya
を再起動してプラグインをロードする必要があります。

Maya で VRML2 プロパティを設定する
VRML2 プラグイン

vrml2Tags コマンドを実行すると、Maya ではダイナミックアトリビュートの
エフェクトを持たないが VRML2 ファイルに追加されるオブジェクトに、タグを
アタッチすることができます。

vrml2Tags コマンドは、scripts/other ディレクトリにある MEL スクリプトファ
イルの vrml2Tags.mel です。

VRML2 プロパティを設定するには

1 VRML2 アトリビュートをアタッチするオブジェクトを選択します。

2 コマンド ライン（Command Line）に vrml2Tags と入力して、vrml2Tags
コマンドを実行します。次のウィンドウが表示されます。

3 このウィンドウで vrml2 タグの設定を変更してAddボタンをクリックしま
す。
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4 アトリビュート エディタ（Attribute Editor）の追加のアトリビュート
（Extra Attributes）セクションで、このアトリビュートをさらに変更でき
ます。

アトリビュートの説明とワークフローについては、以降を参照してください。

VRML2Link を使ってオブジェクトを Web アドレスにリンクする

Link と Message（Msg）アトリビュートで、ハイパーテキストのリンクの作成、
確認、削除を行います。

オブジェクトを Web アドレスにリンクするには

1 リンクさせたいオブジェクトを選択します（複数選択可）。

2 vrml2Tags の MEL コマンドを実行して、VRML2 の現在のタグ情報を表示
します。コマンド ライン（Command Line）に vrml2Tags と入力します。

3 ウィンドウ下部にある Add ボタンをクリックします。

vrml2 TagsWin ウィンドウで Add ボタンを押すと、選択したオブジェク
トのアトリビュート エディタ（Attribute Editor）の追加のアトリビュート
（Extra Attributes）セクションからアトリビュートにアクセスできるよう
になります。

4 vrml2 Link ボックスに URL を入力します。例:

http://www.alias.com

また、次の形式でリンク先の説明文を追加することもできます。
URL*DESCRIPTION

ここで、URL はリンク先のアドレス、アスタリスク (*) はセパレータ（区
切り文字）、DESCRIPTION は、リンクを指定した時に VRML ブラウザに
表示される説明文です。
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例:

http://www.alias.com*Alias Web Page

5 ファイル > すべてエクスポート（File > Export All）を選択してシーンを出
力した場合、オブジェクトはアクティブな VRML リンクになります。

VRML ビューポイントを作成する

ビューポイントは、VRML ワールドであらかじめ設定されたカメラの位置と視
点です。ビューポイントを作成すると、VRML ワールドのナビゲーションが容
易になります（たとえば、エントランスポイントに戻ったり、オブジェクトを
クローズアップして表示したりできる）。

VRML ビュー ポイントを作成するには

1 カメラを新規に作成します。

2 作成したカメラに名前を付けます。カメラ名には VRML2 で有効な文字の
みを使用します。したがって、ダッシュ、[]、{} は使用できません。たとえ
ば、EntranceViewは VRML2 カメラの名前として有効です。

3 vrml2 Link フィールドの URL に、このページの使用するビューポイント
の名前を # を付けて入力します。例:

#EntranceView

vrml2TagsWinウィンドウアトリビュートについて

次に、vrml2TagsWin ウィンドウのアトリビュートについて説明します。
vrmlTagsWin ウィンドウで設定し、Add ボタンで追加したすべてのアトリビュー
トは、そのオブジェクトのアトリビュート エディタ（Attribute Editor）の追加
のアトリビュート（Extra Attributes）セクションに表示され、編集することが
できます。

vrml2 Billboardメニュー

VRML2 billBoard オプションには、VRML2 の標準オプション（None、
X-Rotating、Y-Rotating、Screen Aligned）が用意されています。
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vrml2 primitiveメニュー

VRML2 primitive オプションには、標準の VRML2 オプション（None、Box、
Cone、Cylinder、Sphere、Elevation Grid）が含まれます。

vrml2 Sensorメニュー

VRML2 sensor オプションには、標準の VRML2 オプション（None、
Cylinder）、Sphere、Plane、Proximity、Touch、Visibility）が含まれます。

vrml2Collisionメニュー

vrml2 Collision オプションには、VRML2 の標準オプション（None、Object）
が用意されています。

Do All selectedチェックボックス

このチェックボックスをオンに設定すると、現在選択されているすべてのオブ
ジェクトに、vrml2TagsWin ウィンドウの設定が追加または更新されます。こ
れをオフに設定すると、vrml2TagsWinウィンドウの一番上に表示されている項
目にのみ設定が使用されます。

このオプションは、複数のオブジェクトを選択している場合に便利です。

Add and Updateチェックボックス

このチェックボックスをオンに設定すると、追加と更新が同時に行われます。
オフに設定して Add ボタンを押すとオブジェクトにダイナミックアトリビュー
トが作成され、デフォルト設定が使用されます。オンに設定すると、現在表示さ
れている設定が使用されて、アトリビュートに割り当てられます。

Addボタン

現在のセレクションリストにある、オブジェクトにデフォルトのダイナミック
アトリビュートを作成する場合は、このボタンをクリックします。詳細について
はDo All selected チェックボックス (13 ページ)とAdd and Update チェック
ボックス (13 ページ)を参照してください。

Deleteボタン

現在のセレクションリストにあるオブジェクトからデフォルトのダイナミック
アトリビュートを削除する場合はこのボタンをクリックします。詳細については

Maya で VRML2 プロパティを設定する | 13



Do All selected チェックボックス (13 ページ)とAdd and Update チェックボッ
クス (13 ページ)を参照してください。

セレクションボタン

4 つのセレクションボタンを使用して、設定を適用するオブジェクトを選択し
ます。このオプションは、複数のオブジェクトを選択している場合に便利です。

左から、最初のオブジェクト、1 つ前のオブジェクト、次のオブジェクト、最後
のオブジェクトを選択します。

設定を適用するオブジェクトは、vrml2TagsWin ウィンドウの一番上の行にリ
ストされます。

Closeボタン

vrml2TagsWin ウィンドウを閉じる場合は、このボタンをクリックします。

wrl2ma を使用して VRML2 ファイルをインポー
トする

wrl2ma スタンドアローンプログラムを使用して、VRML2 ファイルを Maya
ASCII に変換することができます。

vrml2 インポータには次のものが含まれます。

（Linux と Mac OS X）wrl2ma

（Windows）wrl2ma.exe

変換されるものは次のとおりです。

■ ジオメトリ

■ 法線

■ テクスチャ座標

■ 頂点カラー

■ シェーダパラメータ（Lambert と Phong）

■ Ttexture ファイルのリファレンス（インラインテクスチャはサポートされて
いません）
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注: アニメーションはこのバージョンではサポートされていません。

wrl2ma を使うには

 ➤ 入力 .wrl ファイルと出力 .ma ファイル、そして必要な拡張子も指定しま
す。

たとえば、システムのシェルまたはターミナルに以下のような内容を入力してく
ださい。

wrl2ma -i Porsc911.wrl -o Porsc911.ma

この例では、VRML ファイル Porsc911.wrl を Porsc.ma という Maya 2011 ASCII
ファイルに変換します。このコマンドには次のようなオプションがあります。

機能オプション

ヘルプ ファイルの表示-h

変換する入力ファイルの指定-i <inputFile>

保存する出力ファイルの指定-o <outputFile>

入力ファイルが Maya 形式で保存されて
いることを示す

-m

冗長メッセージの表示-v

デバッギング ツールを使用して、
libvrml97 のシーン パーサがオリジナルの

-d

VRML ファイルを解析する方法を確認す
る。
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メニュー

ファイル（File）

ファイル > すべてエクスポート > vrml2（File >

Export All > VRML2）

Animation Options

Range Controlオプション
Loop アニメーションをループ再生する VRML2 オプションをオンに設定しま
す。

Time Slider このオプションウィンドウの設定ではなく、メインウィンドウの
タイムスライダで設定した開始/終了フレームを使用します。

Enabled 再生レンジをリセットすることなく、すぐにアニメーションをオフにし
ます。

Start/End Start は出力を開始するフレームを指定します（整数）。End は出力
を終了するフレームを指定します。

Step Start フィールドに入力したフレームから何フレームごとにエクスポートす
るかを設定します。

Frames per sec VRML2 の再生フレームレートを指定します。

Animate
次のオプションをオンに設定する場合は、チェックボックスをクリックします。
オンに設定するとチェックマークが表示され、選択したオプションがアニメー
トされます。

Vertices 各フレームでの頂点のアニメーションをエクスポートします（NURBS
ジオメトリの場合は処理速度が下がることがあります）。デフォルトでは、オフ
に設定されています。

Transf 各フレームでのトランスフォームのアニメーションをエクスポートしま
す。このオプションのデフォルトはオンです。
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Materials シェーダマテリアルのパラメータのアニメーションをエクスポートし
ます。このオプションのデフォルトはオンです。

Lights ライトのパラメータのアニメーションをエクスポートします。このオプ
ションのデフォルトはオンです。

Cameras カメラの処理情報を制御します。

Keyframe using Anim Curves

アニメーションカーブのキーフレーム単位で出力します。デフォルトでは、オ
フに設定されています。（注: このオプションは、今後のバージョンアップで使
用できる予定です）。

Export Options

エクスポートする要素を指定します。

Hierarchy

World Worldをオンに設定すると、VRML2 トランスレータに階層をエクスポー
トしないように指示します。したがって、すべての頂点はワールド空間を使用し
ます。

Flat Flat は 1 階層のみをエクスポートします。したがって、Flat をオンに設定
すると、トランスフォームはワールド空間を使用し、頂点はローカル空間を使用
します。階層情報や親子関係はエクスポートされません。Hierarchyのデフォル
ト設定です。

Full Full は、DAG ツリーの階層全体をエクスポートします。したがって、トラ
ンスフォームも頂点もローカル空間を使用します。完全な階層情報と親子関係が
エクスポートされます。

Joints 階層情報として NULL チェーンを出力します。多くの場合、スケルトン
またはジョイントで使用します。

Export

All すべてのシーン情報（シーン内の可視情報）をエクスポートします。Export
のデフォルト設定です。

Picked シーン内で選択されたすべてのノード（DAG ツリーで、選択されたオブ
ジェクトの DAG ノードより下位のノードは含まれません）をエクスポートしま
す。
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Active シーン内で選択されたすべてのノードと、DAG ツリーでそれより下位に
あるオブジェクトの情報をエクスポートします。

Tessellation

Tri NURBS サーフェスを三角形にテッセレーションします。Tessellation のデ
フォルト設定です。

Quad NURBS サーフェスを四角形にテッセレーションします。

Include

Cameras Camera（カメラ）の情報をデータベースに格納します。このオプショ
ンのデフォルトはオンです。

Lights Light（ライト）の情報をデータベースに格納します。このオプションの
デフォルトはオンです。

Debug Info

Geo/Mat エクスポート時に多くの情報を出力します。シェイプやマテリアルの
情報も出力されます。

Cameras カメラの処理情報を制御します。

Lights ライトの処理情報を制御します。

Texture Options

Evaluate convertSolidTx コマンドを使用して、ファイルテクスチャとプロシー
ジャテクスチャの両方のイメージファイルを作成します。このオプションをオ
フに設定すると、Maya はファイルテクスチャはそのまま読み込み、プロシー
ジャテクスチャのみを変換します。

Sample 2D テクスチャプレイスメントのトランスフォーム情報を使用して、出
力用にファイルイメージを作成します。たとえば、チェッカテクスチャのイメー
ジが 8x8 マスのチェッカボードからなる場合、Sample をオフに設定すると、
Repeat UV を 1 に、Rotate UV を 0.0 にそれぞれ内部的に設定してテクスチャ
が処理されます。その結果、チェッカイメージは 2x2 マスのチェッカになりま
す（デフォルトの 4 repeat とした場合）。

Original ファイルテクスチャイメージの場合、このオプションをオンに設定す
ると、Texture ノードで設定したオリジナルのファイルテクスチャのリファレ
ンス（参照情報）を使用します。
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解像度設定

値を入力して、Enter キー（Linux と Windows）または Return キー（Mac OS
X）を押すか、スライダをドラッグして、以下の X と Y のテスクチャ解像度の
スウォッチサイズを設定します。

X Tex Res/ Y Tex Res プロシージャテクスチャに使用する X/Y サンプルサイズ
を指定します。

Max X Tex Res/ Max Y Tex Res すべてのテクスチャに使用する最大 X/Y サンプ
ルサイズを指定します。ここで指定したサイズよりも大きいファイルテクスチャ
は、convertSolidTx コマンドで計算されて指定されたサイズ内にスケールされ
ます。

Texture Search path

これは、ワークスペース -q -rd で取得したディレクトリのデフォルトリストで
ファイルテクスチャが検出されない場合に、検索対象となるディレクトリのリ
ストです。

VRML2 options

Navigation

このフィールドには、VRML2 のナビゲーションモードがリストされます。これ
らのモードは、.wrl ファイルを開いたときの VRML ブラウザ（ビューア）の初
期設定を制御します。モードを選択してクリックし、オンに設定します（チェッ
クマークを付けます）。

Walk Walk ナビゲーションモードは、バーチャルな世界を徒歩で、または空中
に静止したり浮かんでいる乗物に乗って探索する場合に使用します。Walk ナビ
ゲーションモードはアップベクトルを Y 方向に定義し、歩行や運転の効果を出
すために地形や重力を適用します。このオプションをオンに設定すると、ブラウ
ザはコリジョン（衝突）の検出をサポートします。デフォルトでは、オフに設定
されています。

Examine Examineナビゲーションモードは、個々のオブジェクトを観賞するた
めのモードで、多くの場合はオブジェクトの回りを回転したり、ビューアを近づ
けたり、遠ざけたりします。このオプションのデフォルトはオンです。

Fly Fly ナビゲーションは Walk ナビゲーションに似ていますが、地形や重力を
無効にしたり、無視したりすることができます。デフォルトでは、オフに設定さ
れています。
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Any Any ナビゲーションモードを選択すると、ブラウザがコンテンツに最も合
うナビゲーションモードを選択し、各モード間をダイナミックに変更できるユー
ザインタフェースが提供されます。このオプションをオフに設定すると、ナビ
ゲーションモードを変更することはできず、Navigation オプションでチェック
したモードしか使用できません。このオプションのデフォルトはオンです。

None None ナビゲーションはすべてのブラウザ固有のナビゲーションユーザ
インタフェースを無効にし、消去します。したがって、Anchor ノードや
loadURL()を含むスクリプトなど、シーンに提供されているメカニズムを使用し
てナビゲートすることしかできなくなります。デフォルトでは、この設定はオフ
になっています。

Options: Headlight

VRML2 ヘッドライトの制御オプションです。このチェックボックスをオンに設
定すると、ビューアがシーンにライトを適用します。このオプションのデフォル
トはオンです。

Navigation speed

このフィールドの値で、VRML2 ナビゲーションスピードを設定します。ビュー
アの初速を変更したい場合は、新規の値を入力し、Enter キー（Linux と
Windows）/Return キー（Mac OS X）を押すか、スライダをドラッグします。

Float precision

これで、小数点以下の桁数を設定します。

Export

次のオプションをオンに設定する場合は、チェックボックスをクリックします。
オンに設定するとチェックマークが表示され、選択した Export オプションが
VRML2 にエクスポートされます。

Normals 法線をエクスポートします。デフォルトでは、オフに設定されていま
す。

Opposite 生成された法線の方向を逆にします（通常必要ありません）。デフォ
ルトでは、オフに設定されています。

Textures テクスチャをエクスポートします。デフォルトでは、オンに設定され
ています。

Long Lines 出力ファイルで長い行を許可します。
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オフに設定すると、VRML のテキストファイルを短い行に分割します（各値が
改行されます）。たとえば、約 80 文字よりも長い行を取り扱えないテキストエ
ディタ（vi など）を使用して出力ファイルを編集する場合は、このオプション
をオフに設定します。デフォルトでは、オフに設定されています。

Verbose トランスレーション時のフィードバックを取得します。デフォルトで
は、オフに設定されています。

Launch viewer オンにすると、トランスレータの終了時に Netscape（Linux）、
または拡張子 .wrl のファイルに関連付けされたプログラム（Windows）が起動
します。このオプションはデフォルトではオフに設定されています。Mac_OS_X
では使用できません。

Compressed gzip プログラムを起動して、出力ファイルを圧縮します。ファイ
ルの拡張子は .wrl のままです。Windows の場合は、実行パスに gzip.exe プロ
グラムが配置されている必要があります。デフォルトでは、オフに設定されてい
ます。

Reversed Opposite オプションがオンに設定されている、片面だけの NURBS
サーフェスの巻上げを逆転させます。このオプションのデフォルトはオンです。

ColorPerVertex 出力されるオブジェクトがポリゴンの場合、そのオブジェクト
のカラーを頂点単位で出力します。デフォルトでは、オフに設定されています。

Texture path

テクスチャは、このフィールドで指定したディレクトリに保存されます。

Run script when done

Browseボタンをクリックして、トランスレーション終了後に実行されるスクリ
プトを選択するか、スクリプトの名前を直接入力します。system() コールが発
行され、実行可能コマンドが PATH ステートメントに置かれます。

Append file name to script

このオプションは、発行されたコマンドラインの末尾に出力ファイルの名前を
追加するかどうかを定義します。このオプションのデフォルトはオンです。
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RTG ユーティリティと
ファイルフォーマット

RTG トランスレータの概要
RTG トランスレータは Maya のシーン情報を一般的に出力する手段を提供しま
す。サイト独自の変更やカスタマイズが行えるように、ソースコードも提供され
ています。

RTG の機能

出力
■ ポリゴンジオメトリ

■ NURBS サーフェス（三角形または四角形にテッセレーションされます）

■ 階層構造（必要な場合）

■ シェーダのパラメータ

■ テクスチャ（SGI の RGBA イメージフォーマット）

■ リジッド TRS アニメーション

コマンド

RTG トランスレータには、MEL コマンドは組み込まれていません。

3
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アトリビュート

RTG トランスレータで参照できる特定の Maya アトリビュートはありません。

このプラグインに必要なファイル

このプラグインを使用するには、次のファイルが必要です。

■ rtgExport.lib（Mac OS X）、rtgExport.so（Linux）、または rtgExport.mll
（Windows）

■ rtgTranslatorOpts.mel

ソースコードは、devkit/obsolete/games/rtgExport にあります。

RTG トランスレータのインストール
プラグイン マネージャ（Plug-in Manager）を使用して、RTG トランスレータ
プラグインをインストールします。

1 ウィンドウ > 設定/プリファレンス > プラグインマネージャ（Window >
Settings/Preferences > Plug-in Manager）を選択して認識されるプラグイ
ンをすべて表示します。

2 プラグインをロードするには、rtgExport.so、rtgExport.mll、または
rtgExport.lib（オペレーティングシステムによって異なります）の隣のロー
ド（loaded）チェックボックスをクリックします。

自動ロード（auto load）チェックボックスのみをオンにした場合は、Maya
を再起動してプラグインをロードする必要があります。
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メニュー

ファイル（File）

ファイル > すべてエクスポート > rtg（File > Export

All > RTG）

RTG トランスレータのオプション

RTG Options

Base options

次のオプションをオンに設定する場合は、チェックボックスをクリックします。
オンに設定するとチェックマークが表示され、選択したオプションが出力時に
適用されます。

Verbose トランスレーション時のフィードバックを取得します。デフォルトで
は、オフに設定されています。

Reversed Opposite オプションがオンに設定されている、片面だけの NURBS
サーフェスの巻上げを逆転させます。デフォルトでは、オンに設定されていま
す。

Image Format

リストから SGI RGB、Alias PIX のいずれかを選択します。

Format

Linux/DOS 出力する ASCII ファイルを Linux <lf> または DOS <cr><lf> フォー
マットから指定します。次のオプションをオンに設定する場合は、チェックボッ
クスをクリックします。オンに設定するとチェックマークが表示され、選択し
たフォーマットオプションが RTG トランスレータに出力されます。

V1.8 Compatible PA rtg 1.8 出力フォーマットの一部をオンに設定します。

V Normals 頂点法線（Vertex Normals）を出力します。
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P Normals ポリゴン法線（Polygon Normals）を出力します。

V Colors 頂点カラー（Vertex colors）を出力します。

UV Coords Games Translators によって UV 座標系を出力します。

indexCnt リストの各エントリの先頭にインデックスカウンタを出力します。

Degrees トランスフォームの角度をラジアンではなく度数で出力します。

Materials シェーディンググループのマテリアルのプロパティを出力します。

MultiTexture Diffuse、Bump、Translucence、Specular Color、Cosine Power
など、テクスチャマップされたマテリアルのプロパティに対し、個別にテクス
チャイメージを出力します。

MDecomp トランスフォームマトリックスを T/R/S のコンポーネントに分解し
ます。

Pivots ピボット情報を出力します。

Transforms トランスフォーム情報を出力します。

Local Xform ローカルなトランスフォームマトリックス [4x4] を出力します。

Animation T/R/S アニメーションを出力します。

All Nodes アニメーションのためにすべてのノードを強制的に出力します。

Animation Options

Range Controlオプション
Time Slider この Options ウィンドウの設定ではなく、メインウィンドウのタ
イムスライダで設定した開始/終了フレームを使用します。

Enabled 再生レンジをリセットすることなく、すぐにアニメーションをオフにし
ます。

Start/End Start は出力を開始するフレームを指定します（整数）。End は出力
を終了するフレームを指定します。

Step Start フィールドに入力したフレームから何フレームごとにエクスポートす
るかを設定します。
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Export Options

エクスポートする要素を指定します。

Hierarchy

World World をオンに設定すると、RTG トランスレータに階層をエクスポート
しないように指示します。したがって、すべての頂点はワールド空間を使用しま
す。

Flat Flat は 1 階層のみをエクスポートします。したがって、Flat をオンに設定
すると、トランスフォームはワールド空間を使用し、頂点はローカル空間を使用
します。階層情報や親子関係はエクスポートされません。Hierarchyのデフォル
ト設定です。

Full Full は、DAG ツリーの階層全体をエクスポートします。したがって、トラ
ンスフォームも頂点もローカル空間を使用します。Full（完全な）階層情報と親
子関係がエクスポートされます。

Joints

階層情報として NULL チェーンを出力します。多くの場合、スケルトンまたは
ジョイントで使用します。

Export

All すべてのシーン情報（シーン内の可視情報）をエクスポートします。Export
のデフォルト設定です。

Picked シーン内で選択されたすべてのノード（DAG ツリーで、選択されたオブ
ジェクトの DAG ノードより下位のノードは含まれません）をエクスポートしま
す。

Active シーン内で選択されたすべてのノードと、DAG ツリーでそれより下位に
あるオブジェクトの情報をエクスポートします。

Tessellation

Tri NURBS サーフェスを三角形にテッセレーションします。Tessellation のデ
フォルト設定です。

Quad NURBS サーフェスを四角形にテッセレーションします。
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Include

Cameras Camera（カメラ）の情報をデータベースに格納します。このオプショ
ンのデフォルトはオンです。

Lights Light（ライト）の情報をデータベースに格納します。このオプションの
デフォルトはオンです。

Debug Info

Geo/Mat エクスポート時に多くの情報を出力します。シェイプやマテリアルの
情報も出力されます。

Cameras カメラの処理情報を制御します。

Lights ライトの処理情報を制御します。

Texture Options

Texture control

Evaluate convertSolidTx コマンドを使用して、ファイルテクスチャとプロシー
ジャテクスチャの両方のイメージファイルを作成します。このオプションをオ
フに設定すると、Maya はファイルテクスチャはそのまま読み込み、プロシー
ジャテクスチャのみを変換します。

Sample 2D テクスチャプレイスメントのトランスフォーム情報を使用して、出
力用にファイルイメージを作成します。たとえば、チェッカテクスチャのイメー
ジが 8x8 マスのチェッカボードからなる場合、Sample をオフに設定すると、
Repeat UV は 1 に、Rotate UV は 0.0 に、それぞれ内部的に設定されてテクス
チャが処理されます。その結果、チェッカイメージは 2x2 マスのチェッカにな
ります（デフォルトの 4 repeat とした場合）。

Original ファイルテクスチャイメージの場合、このオプションをオンに設定す
ると、Texture ノードで設定したオリジナルのファイルテクスチャのリファレ
ンス（参照情報）を使用します。

解像度設定

値を入力して、Enter キー（Linux と Windows）または Return キー（Mac OS
X）を押すか、スライダをドラッグして、以下の X と Y のテスクチャ解像度の
スウォッチサイズを設定します。

X Tex Res/Y Tex Res プロシージャテクスチャに使用する X/Y サンプルサイズ
を指定します。
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Max X Tex Res/Max Y Tex Res すべてのテクスチャに使用する最大 X/Y サンプ
ルサイズを指定します。すべてのテクスチャに使用する最大 X/Y サンプルサイ
ズを指定します。ここで指定したサイズよりも大きいファイルテクスチャは、
convertSolidTx コマンドで計算されて、指定サイズ内にスケールされます。

Texture Search path

これは、ワークスペース -q -rd で取得されるディレクトリのデフォルトリスト
でファイルテクスチャが検出されない場合に、検索対象となるディレクトリの
リストです。
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Game Exchange 2 トランス
レータ

GE2 トランスレータの概要
GE2 トランスレータは、Maya のシーンファイルを GE2 フォーマットにエクス
ポートします。

GE2 の機能

GE2 の出力 (31 ページ)とこのプラグインに必要なファイル (32 ページ)は、次の
通りです。

出力
■ ポリゴンジオメトリ

■ NURBS サーフェス（三角形または四角形にテッセレーションされます）

■ 階層構造（必要な場合）

■ シェーダのパラメータ

■ テクスチャ: 使用できるフォーマットは、SGI RGBA、Alias wirefile、bmp、
png、ppm、tif です。

注: GE2 エクスポートでは、変換されたテクスチャに対する .bmp 形式のイ
メージファイルは正しく生成されません。.sgi または .tif 形式を代わりに指定
し、テクスチャを .bmp に変換することをお勧めします。

4

31



■ TRS アニメーション

■ 頂点のアニメーション

コマンド

GE2 アトリビュートを Maya のシェーダに割り当てるには、ge2tags コマンドを
使用します。ge2tags コマンドを実行すると、GE2 Material アトリビュートに対
応する新規のアトリビュートセットがすべてのシェーダに追加されるとともに、
GE2 アトリビュートがタブ付きの見やすい形式でアトリビュート エディタ
（Attribute Editor）に表示されるようになります。

アトリビュート

ge2tags コマンドを実行すると、GE2 Material アトリビュートに対応する新規の
アトリビュートセットがすべてのシェーダに追加されます。このアトリビュー
トは、ほかのアトリビュートと同様の方法で編集または参照することができま
す。

このプラグインに必要なファイル

このプラグインを使用するには、次のファイルが必要です。

■ ge2Export.lib（Mac OS X）、ge2Export.so（Linux）、または ge2Export.mll
（Windows）

■ ge2TranslatorOpts.mel

■ ge2tags.mel

■ ge2MatAttr.mel

■ AElambertGE2Revision.mel

■ ソースコードは、devkit/obsolete/games/ge2Export ディレクトリにありま
す。

GE2 トランスレータのインストール
プラグイン マネージャ（Plug-in Manager）を使用して、プラグインの GE2 ト
ランスレータをインストールします。
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プラグインをロードするには

1 ウィンドウ > 設定/プリファレンス > プラグインマネージャ（Window >
Settings/Preferences > Plug-in Manager）を選択して認識されるプラグイ
ンをすべて表示します。

2 ロード（loaded）、または自動ロード（auto load）チェックボックスをク
リックして、ge2Export.mll、ge2Export.so、または ge2Export.lib プラグ
インのいずれかをロードします。

メニュー

ファイル（File）

ファイル > すべてエクスポート > GE2（File > Export

All > GE2）

Domain Options

次のオプションをオンに設定する場合は、チェックボックスをクリックします。
オンに設定するとチェックマークが表示され、選択したオプションが出力時に
適用されます。選択したドメインにはマテリアルのアトリビュートが表示されま
す。

Format data for domain: オプションには、GL/DirectX、SonyPSX、N64、
Custom があります。

Animation Options

Enable Animation

再生レンジをリセットすることなく、すぐにアニメーションをオフにします。

Start/End Start は出力を開始するフレームを指定します（整数）。End は出力
を終了するフレームを指定します。
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Step Stepオプションは、Keyframe using: Anim Curvesオプションをオフに設
定した場合にのみ使用可能になります。Start フィールドに入力したフレームか
ら何フレームごとにエクスポートするかを設定します。

Animate options

次の各チェックボックスをクリックして、オン/オフを切り替えます。

Vertices オンに設定すると、頂点のアニメーションをエクスポートします。

Transforms オンに設定すると、トランスフォームアニメーションをエクスポー
トします。

Lights オンに設定すると、シーン内のライトのアニメーションをエクスポート
します。

Camera オンに設定すると、シーン内のカメラのアニメーションをエクスポート
します。

Keyframe usingオプション

次の各チェックボックスをクリックして、オン/オフを切り替えます。

Anim Curves オンに設定すると、Shape ノードのアニメーションカーブからキー
フレームが抽出されます。また、エクスポートされるフレーム上にキーフレーム
が確実に配置されるように、Step オプションは 1 に固定され変更不可になりま
す。オフに設定すると、Step オプションが使用可能になり、デフォルト値を変
更することができます。

Sampling オンに設定すると、Maya がアニメーションを適応サンプリングしま
す。また、Sample By と Tolerance の各オプションが使用可能になります。ジ
オメトリが許容レベル（Tolerance）を満たしていない場合、指定したレートで
フレームがサンプリングされてキーフレームとしてエクスポートされます。

Sample By Sample By を使用可能にするには、Keyframe Using セクションで
Samplingが選択されていなければなりません。このオプションの値は、適応サ
ンプリングするためのサンプリングレートを表します。

Tolerance Sample By を使用可能にするには、Keyframe Using セクションで
Samplingが選択されていなければなりません。このオプションの値は、サンプ
リングするフレームをキーフレームとしてエクスポートするかどうかを決定しま
す。
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Animation Displacementオプション

これらのオプションは、Animation セクションで Vertices を選択した場合にの
み使用可能になります。

■ Relative to Current Frameでは、頂点の相対的なディスプレイスメントを指
定します。

■ Absolute: 頂点の絶対的なディスプレイスメントを生成します。

Export Options

エクスポートする各エレメントとそのエクスポート方法を指定します。

Hierarchy

World World をオンに設定すると、GE2 トランスレータに階層をエクスポート
しないように指示します。したがって、すべての頂点はワールド空間を使用しま
す。

Flat Flat は 1 階層のみをエクスポートします。したがって、Flat をオンに設定
すると、トランスフォームはワールド空間を使用し、頂点はローカル空間を使用
します。階層情報や親子関係はエクスポートされません。Hierarchyのデフォル
ト設定です。

Full Full は、DAG ツリーの階層全体をエクスポートします。したがって、トラ
ンスフォームも頂点もローカル空間を使用します。完全な階層情報と親子関係が
エクスポートされます。

Export

All すべてのシーン情報（シーン内の可視情報）をエクスポートします。Export
のデフォルト設定です。

選択された状態 シーン内で選択されたすべてのノード（DAG ツリーで、選択さ
れたオブジェクトの DAG ノードより下位のノードは含まれません）をエクス
ポートします。

Active シーン内で選択されたすべてのノードと、DAG ツリーでそれより下位に
あるオブジェクトの情報をエクスポートします。

Tessellation

Tri NURBS サーフェスを三角形にテッセレーションします。Tessellation のデ
フォルト設定です。
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Quad NURBS サーフェスを四角形にテッセレーションします。

Export

これらのオプションがオンに設定されていると（デフォルトでは、Export のす
べてのオプションがオンに設定されています）、ライト、カメラ、テクスチャ、
ジオメトリ、法線に関する情報がエクスポートされます。

Export options

次のオプションはデフォルトではオフに設定されています。

Reverse winding オンに設定すると、ポリゴンの巻上げを反転させます。デフォ
ルトの巻上げは反時計回りです。

Flip Normals オンに設定すると、法線の方向を反転させます。デフォルトでは、
オフに設定されています。

Texture Options

テクスチャコントロール

convertSolidTx コマンドを使用して、ファイルテクスチャとプロシージャテク
スチャの両方のイメージファイルを作成します。このオプションをオフに設定
すると、Maya はファイルテクスチャはそのまま読み込み、プロシージャテク
スチャのみを変換します。

Use 2d and 3d texture placement Uses the 2D texture placement のトランス
フォーム情報を使用して、出力用にファイルイメージを作成します。たとえば、
チェッカテクスチャのイメージが 8x8 マスのチェッカボードからなる場合、
Repeat UV は内部的に 1、Rotate UV は 0.0 にそれぞれ内部的に設定されて、テ
クスチャが処理されます。その結果、チェッカイメージは 2x2 マスのチェッカ
になります（デフォルトの 4 repeat とした場合）。

Use convertSolidTx on file textures このオプションは、今後のバージョンアッ
プで使用できる予定です。

Use original file textures このオプションをオンに設定すると、Maya はファイ
ルテクスチャはそのまま読み込み、プロシージャテクスチャのみを変換します。
オフに設定すると、ファイルテクスチャとプロシージャテクスチャの両方を変
換します。
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解像度設定

値を入力して、Enter キー（Linux と Windows）または Return キー（Mac OS
X）を押すか、スライダをドラッグして、以下の X と Y のテスクチャ解像度の
スウォッチサイズを設定します。

X Tex Res/Y Tex Res プロシージャテクスチャに使用する X/Y サンプルサイズ
を指定します。

Max X Tex Res/Max Y Tex Res すべてのテクスチャに使用する最大 X/Y サンプ
ルサイズを指定します。すべてのテクスチャに使用する最大 X/Y サンプルサイ
ズを指定します。ここで指定したサイズよりも大きいファイルテクスチャは、
convertSolidTx コマンドで計算されて、指定サイズ内にスケールされます。

Texture path

これは、ワークスペース -q -rd で取得したディレクトリのデフォルトリストで
ファイルテクスチャが検出されない場合に、検索対象となるディレクトリのリ
ストです。

Other Options

Float precision

小数点以下の桁数を設定します。

Format Output

Tabs オンに設定すると、出力ファイルの中身にタブが付いて読みやすなります。
このオプションのデフォルトはオンです。

Comments オンに設定すると、出力にコメント（番号付きインデックスなど）
が付きます。デフォルトでは、オフに設定されています。

Debug Output

次のオプションはデフォルトではオフに設定されています。

Geometry オンに設定すると、エクスポート中にジオメトリに関する情報とジオ
メトリ（マテリアルも含む）に関連付けられているすべての情報が出力されま
す。この処理時に大量の情報が生成されます。

Cameras オンに設定すると、エクスポート中にカメラの情報が出力されます。

Lights オンに設定すると、エクスポート中にライトの情報が出力されます。
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Run script when done

GE2 ファイルをほかのファイルフォーマットに変換したり、ファイルを後処理
するために、エクスポート後に実行されるスクリプトとコマンドラインオプショ
ンを指定します。

Append file name to script

このオプションをオンに設定すると、スクリプトの実行前に、Run script when
done フィールドで指定したスクリプトの末尾に適切なファイル（.grp または
.gaf ファイル）が追加されます。
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MDt API

ゲームエクスポートツールキットの概要
重要: 直接 Maya の API をお使いになることをお勧めしています。MDT レイヤが
Maya 1.0 用に開発されて以来、API にいくつもの関数が追加されたので、MDT
レイヤを使用する必要は減りました。またソースコードも、devkit/obsolete/games
に移動しました。

MDtApi は、『GAME EXPORT toolkit for Maya』を Maya に実装したもので、
Maya API 用のラッパーレイヤです。主な目的は次のとおりです。

■ 複数のトランスレータ間で共通のコードを再利用できるようにする。

■ PA ゲームトランスレータから Maya への変換を容易にする。

■ Maya API から得られるグルーピング情報のレベルを提供する。

■ Maya API のサンプルソースコードを提供する。

注: Maya API は決して MDtApi に代替されるインタフェースレイヤではあり
ません。MDtApi 関数は Maya API を使用して動作します。
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関数を組み込む
MDtApi は、トランスレータをリンクできるスタティックライブラリにコンパ
イルされています。MDtApi ライブラリを構成するファイルは次のとおりです。

ジオメトリのグループ化（頂点、法線、
カラー、テッセレーション）

MDtShape.cpp

シェーダ、テクスチャ イメージの生成、
マテリアルのプロパティ

MDtMaterial.cpp

その他の制御関数/起動/クリーンアップMDtLayer.cpp

ライトのパラメータMDtLight.cpp

カメラのパラメータMDtCamera.cpp

現在は使用不可MDtCnetwork.cpp

iff ファイルを読み取るクラスiffreader.cpp

iff ファイルを書き込むクラスiffwriter.cpp

MDtApi の主要ヘッダー ファイルMDt.h

Maya API での使用を可能にするための、
MDtApi の拡張関数、オリジナルの Maya

オブジェクトへのアクセス

MDtExt.h

MDt ライブラリを使用する
MDt ライブラリは、シーンの DAG 構造をスキャンして、MDt 関数が参照でき
る内部データテーブルが生成されてはじめて機能します。このプロセスは、大
きなファイルや NURBS サーフェスでは多少時間がかかる場合があります。内部
データテーブルの生成にかなりの時間がかかるときは、Maya API を直接使用し
た方がいい場合があります。
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データテーブルが生成されると、トランスレータはこのテーブルにアクセスし
て、必要なフォーマットでデータを出力します。また、DAG ツリーを再度スキャ
ンしなくても参照して追加データを入手できるように、オリジナルの Maya オ
ブジェクトへのリファレンスも一時的に格納されます。

MDt データテーブルでキャッシュされない情報を入手する場合は、まず MDt
関数を使用して、その後で Maya API を使用してください。

ヒント: 最初に Maya API を使用して、その後 MDt 関数を使用しないようにし
てください。まず MDt 関数を使用してトランスレータをクイックスタートした
りプロトタイピングして、その後、習得した知識を活用してトランスレータを微
調整/カスタマイズするようにしてください。

API 関数のマニュアルを調べる
MDtApi のマニュアルは、可能な限りソースファイルに組み込まれています。

MDt ライブラリを使用する
MDtApi は Maya API を使用する 1 つの方法にすぎません。MDtApi は、Maya
からシーン情報を取得するための唯一の方法というわけではありません。MDtApi
は、Maya API 関数と MEL コマンドの実行を組み合わせてデータにアクセスす
る方法です。

MDtApi は Maya API に代替されるものではありません。さまざまなユーザに
とって必要な共通の関数をまとめたものと考えることができます。たとえば、す
べてのシェーダ（Shader）アトリビュートがデータベースにキャッシュされる
わけではありません。静的で繰り返し使用されることが検出されたアトリビュー
トのみがキャッシュされます。しかし、この API は、オリジナルの Maya オブ
ジェクトを参照して、必要な追加データを取得することができます。したがっ
て、MDtApi は共通ルーチンの上位にあるグルーピング関数と考えることができ
ます。

内部データベースを生成し、次にそのデータを使用してトランスレータを実行す
るという、2 段階のプロセスが一般的です。DAG ツリーをスキャンして内部デー
タベースを生成するには多少時間がかかります。その場合は、Maya API を直接
使用する、より高速なトランスレータを書くことができます。VRML2 やほかの
MDt ベースのトランスレータに使用されているアプローチは、各トランスレー
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タに対して同じことを繰り返すという作業負荷を軽減し、既存のトランスレータ
で可な関数を再利用するというものです。

VRML2、RTG、GE2 ゲームトランスレータは、「ファイルトランスレータ」
として実装されています。これらは通常の Maya MPxCommand プラグインと
しても実装可能です。

内部データベースの構造

DAG ツリーをスキャンして生成される内部データベースは、ファイルトランス
レータのオプションボックスでユーザが設定するオプションで制御することが
できます。

内部データベースは、次の情報を収集して生成されます。

Shape、Group、Material、Texture、Light、Camera

Controls（コントロール）

Controls オプションについては、MDtApI を使用して実行する各ゲームトラン
スレータのセクションで説明しています。

これらのオプションはかなりフレキシブルに設定することができます。また、
ソースコードも提供されているため、別のオプションを追加してローカルにカ
スタマイズすることもできます。

このオプションはファイル MDtLayer.cpp とヘッダファイル MDtExt.h に実装
されます。ソースコードにさらにコントロールフラグを追加することも、MEL
オプションスクリプトを修正して、オプションを設定/リセットすることもでき
ます。

さらに、各オプションに対して特定の関数を持たせた MDt ファイルを変更した
り、トランスレータのオプションの MEL スクリプトファイルを変更してオプ
ションの値をトランスレータ自体に渡すこともできます。

Shapes（シェイプ）

Shape は、基本的なトランスフォーム、ジョイント、ポリゴン/NURBS オブジェ
クトに関する情報です。各 Shape にはそれぞれ関連するパラメータがあります。

■ Transoformations（変換）

■ Materials/Groups（マテリアル/グループ）

■ Parents（ペアレント）
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また、各 Shape にはそれぞれ関連する Groups リストがあります。Shape が純
粋なトランスフォームノードまたはジョイントノードの場合、Groups 数は 0
になります（シェーダが割り当てられていません）。これは通常、階層を FULL
に設定した場合や、すべてのトランスフォームがフラットに行われている場合、
あるいはジオメトリがすべての Shape に関連付けられている場合に起こります。

Shape インデックスを使用して動作する API 関数には、次のようなものがあり
ます。

■ DtShapeGetCount(): 検出された Shape ノードの数を返します。

■ DtShapeGetMatrix(idx, *matrix): shape idx のトランスフォームマトリッ
クスを変数マトリックスで返します。

一般に、ByGroup ではなく ByShape ベースの関数を使用してジオメトリ情報を
取得した方が処理が速くなります。ただし、コール側に渡される二次コピーは生
成されません。

Shape 関数は、MDtShape.cpp ファイルにあります。

Groups（グループ）

Groups は Shape を構成するサブセットで、Shape に割り当てられた複数のシェー
ダによって定義されます。NURBS オブジェクトでは、最大でも 1 つの Group
しかありません。ポリゴンオブジェクトでは、割り当てられた各シェーダに対
して 1 つの Group があります。ポリゴンオブジェクトにシェーダが割り当てら
れていなければ、Group 数は 0 になります。この場合、ほとんどが何らかのト
ランスフォームノードです。

ByGroup 関数は、リストを生成して返す際にメモリを割り当てることが必要で
す。API 関数はメモリが解放されたことを認識しないため、リストが返されたら
ユーザが解放しなければなりません。

これらの関数は MDtShape.cpp ファイルにあります。

Materials（マテリアル）

Material は、DAG ツリーをスキャンして検出されたシェーダです。

検出された各シェーダについてリファレンスが作成され、name または ID 番号
のいずれかでアクセスできます。このリファレンスを使用して、Maya API を直
接コールし、目的のシェーダのパラメータを取得することができます。

これらの関数は MDtMaterial.cpp ファイルにあります。
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Textures（テクスチャ）

Texture はシェーダにマップされたテクスチャです。デフォルトでは、カラー
テクスチャと透明テクスチャだけが評価されて、RGBA 複合ファイルイメージ
がメモリに作成されます。さらに処理を行って、シェーダにマップされたすべて
またはほとんどのテクスチャを出力することもできます。これは、MultiTexture
オプションの一部です。

これらの関数は MDtMaterial.cpp ファイルにあります。

Lights（ライト）

ライトの情報を収集して使用することができます。Material と同様、リファレ
ンスが一時的に記憶され、目的のライトのパラメータにアクセスすることができ
ます。

これらの関数は MDtLights.cpp ファイルにあります。

Camera（カメラ）

カメラの情報を収集して使用することができます。Material と同様、リファレ
ンスが一時的に記憶され、目的のカメラのパラメータにアクセスすることができ
ます。

これらの関数は MDtCamera.cpp ファイルにあります。

Utility（ユーティリティ）

マトリックスの分解やほかの一般的な機能を提供するユーティリティ関数も用意
されています。これらの関数は、DAG ツリーのスキャンを制御するオプション
と一緒に MDtLayer.cpp ファイルにあります。

Animation（アニメーション）

MDt 関数からアニメーションデータを取得する方法は、アニメーション以外の
データを取得する方法とまったく同じです。

DAG ツリーをスキャンして内部データベースが作成されると、リファレンスが
保存され、これを使用して必要なジオメトリやマテリアルの情報を取得すること
ができます。

カレントフレームタイムを設定する DtFrameSet(frame) コールを使用してアニ
メーションレンジにわたりこの操作を繰り返すと、ディペンデンシーグラフが
自動的に更新されます。
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各フレームについて、DtFrameSet コールが必要なパラメータを更新します。現
在のところ、同じファンクションコールを再利用して次のフレームのジオメト
リデータが取得できるように、そのほとんどはジオメトリ（頂点、法線、UV）
が対象です。

トランスフォームデータはトランスフォームオブジェクトを参照して取得され
ます。ただし、トランスフォームデータはキャッシュされません。

アニメーションレンジに対する、この繰り返し操作の回数は最小限に抑えるこ
とをお勧めします。次にその例を示します。

for ( animation = start, to end )

for ( shape = 0, to last Shape )

get and save TRS data for shape

next shape

next frame

最小限のプログラム例
MDt 関数を使用するために最低限必要なプラグイン操作は次の通りです。

■ 内部データベースの初期化

■ Maya シーングラフのスキャンと内部データベースの作成

■ 内部データベースの解放

関数のコールに必要なコード例（断片）を次に示します。このコードは実際に何
も出力はしません。通常は、内部データベースの作成方法をカスタマイズするた
めのコールを追加したり、データを検索して出力するための実際のコールが必要
となります。次に例を挙げます。

// Initialize the internal database with a scene “name”

DtExt_SceneInit( “basic” );

//Now we can setup the database from the wire file geometry

DtExt_dbInit();

// Clean house.

DtExt_CleanUp();
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基本的なプログラム例
次に、基本的な Dt ベースのプラグインを使用して選択したオブジェクトに照会
し、Shape の名前と、シェーダにマップされた color テクスチャのファイル名を
出力するプログラム例を示します。
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#include <maya/MSimple.h>

#include <MDt.h>

#include <MDtExt.h>

DeclareSimpleCommand( basic, "Alias - Example", "2.0");

void outputFileNames()

{

char *shapeName;

char *mtlName;

char *texName;

// 1st thing find out how many shapes (meshes) are in this scene

// currently being looked at.

int numShapes = DtShapeGetCount();

// For each shape, check out what is assigned as the color texture

// There may not be a texture associated with material, or the

texture

// may be a procedural texture and so have no file name.

for ( int shape=0; shape < numShapes; shape++ )

{

// Find the name of the current shape that we are looking at.

DtShapeGetName( shape, &shapeName );

// Find out the number of groups (materials) assigned to this shape

numGroups = DtGroupGetCount( shape );

// For each group (material) check out to see if there is a file

texture

// associated with the material and output its name.

// It is possible that the number of groups will be zero. In this

case

// there would be no materials assigned:

// 1) Joint or other Transform node

// 2) user deleted all of the materials including the default

shading group

// 3) removed the connections between the mesh and the shading

groups.

// Usual reason is #1, a Joint or straight Transform node. (when

using

// full hierarchy mode

for ( int group=0; groups < numGroups; group++ )

{

// For the current shape+group combination find out its material

DtMtlGetName( shape, group, &mtlName );
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// For the current material, find out its texture file name if

any

DtTextureGetFileName( mtlName, &texName );

// output any information that is wanted about what we found

above.

printf( "for shape %s(%d) group %s(%d), texture filename is %s\n",

shapeName, shape, mtlName, group, texName ? texName : "(NULL)" );

}

}

}

//

// main doIt function for the plugin command.

MStatus basic::doIt( const MArgList& args )

{

// Initialize the Dt database

DtExt_SceneInit( “basic” );

// using the default settings, as no initializer

// functions are called here

// Walk the dag and fill in the internal database

DtExt_initdb();

// walk thru shapes found and output the texture file names

outputFileNames();

// Clean up the allocated memory and internal storage

DtExt_CleanUp();

// return from the plugin command

return MS::kSuccess;

}
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